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1 Introduction 
This document contains an overview of the concepts behind Focus X2 and should be used in conjunction 
with the help pages built into Focus. At the time of writing, the latest version of Focus is v1.5 build 1123.  If 
you are running an older build of Focus, we recommend you take advantage of a free upgrade from 
http://www.elitesportsanalysis.com/download.htm.  To check which version you have, start Focus X2 then 
click on ‘help’ then ‘About’. 

1.1 About Focus X2 
Focus X2 combines powerful video and statistical analysis into a software tool designed specifically with 
sports coaches in mind. 

> Starting with the simple category design tool you can quickly create a Focus category set that will 
allow you to record information on any aspect of performance. 

> Working with team video, you use your categories to log play events. 

> Review play by clicking on an event, the viewer takes you to the exact point in the video where the 
action took place. 

> You can sort and filter events to focus on aspects of play, specific players etc. 

> Present visual feedback to your athletes or create highlight clips. 

1.2 System Requirements 

1.2.1 Hardware 

> Pentium II, 400MHz or higher 

> 128MB RAM min, 256MB recommended 

> 800x600 pixel display min, 1024x768 recommended 

> 10MB disk space for Focus X2 

> 1GB disk space per 5 minutes of video, external Firewire hard disk recommended to store video 

> IEEE-1394 (Firewire / iLink) port for video captures 

1.2.2 Software 

> Windows 98, 98 SE, ME, 2000, XP Home, XP Professional 

> Microsoft DirectX® version 9.0 (included inside XP and can be downloaded from Microsoft for other 
Windows versions) 
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2 Background Concepts 

2.1 Before You Start 
Focus X2 is used to generate accurate and objective statistical information through a process of 
systematic observation.  The interactive video facility enhances the value of the information gathered by 
allowing the coach to view the context in which these important events occurred. 

The statistical information, together with the Interactive video facility can be used to: 

> Identify key aspects of individual or team performance in a more effective manner than ever before. 

> Uncover previously unidentified performance issues. 

Before starting to use Focus, you need to decide on those areas of performance that you wish to study in 
more detail. 

2.2 High-Level Analysis 
You need to start with some idea of what aspects of play you are interested in.  To ensure that you use 
the Focus X2 software to best effect, it is vital that careful thought is given to identifying those aspects of 
performance on which you want to both gather information on and view interactively on video. 

The key starting point is to identify what aspects of play will have the most significant effect on a game.  
These will be different for different sports, teams, and levels of competition and may even change from 
game to game or performance to performance.  This analysis could focus on particular players, specific 
aspects of play (e.g. missed tackles or service return) or areas of the court or pitch.  Or of course some 
combination of all of these. 

Having decided on an aspect of play it is useful to set targets for improvement.  Focus can then be used 
as a platform to measure performance against your targets and for feedback to the athletes. 

2.3 Projects And Categories 
Focus is based on the concept of projects and categories.  A project consists of a set of linked 
information, included within the project are: 

> A category set defining the aspects of play to be covered in this project. 

> A video play list containing the video clip files showing play. 

> An event list containing all the events you log for this project. 

When you create a new project, you will be asked for a category set.  Once the project has been created 
the category set is fixed for that project and cannot be changed.  Focus downloads with a sample category 
set for soccer and more categories will be available from the Elite Sports Analysis web site.  However, it is 
recommended that you create your own category sets based on your sport and your individual set of 
requirements. 

2.3.1 Categories 

A category is a description of the aspect of play you wish to analyse in a form that Focus can understand.  
When an event is logged in Focus it contains all the items defined in the category.  For example the 
sample soccer category that you downloaded with Focus has the following defined: 

> Category 1 - Team (which team the event applies to e.g. Team A). 

> Category 2 - Play Event (what type of event occurred e.g. goal). 

Typically, a category set will record: 

> Who was involved 

> What sort of play happened 

> Where the event occurred on the pitch/court 

> What was the outcome 

> The logging of when an event occurred is recorded automatically by Focus 
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When the category is defined in Focus a set of buttons is created.  There are buttons for each option in 
the category and you have the ability to change the layout of the buttons and define keyboard short cuts 
for fast event logging.  When you log events, you click on the buttons to create the information for the 
event. 

2.4 Using Video 
Focus can view video in analogue or digital video (DV) format where the source is a file in AVI or MPG 
format.  When capturing video, Focus works with DV only and captured clips are in AVI format.  Typically, 
captured video would come from a digital camera via a Firewire connection or from a DV file on disk. 

When video is stored on disk either by Focus or some other video capture program, the DV is wrapped 
inside an AVI file.  Although there are many sub-sets of AVI files, Focus should be able to play the most 
common types without problems. 

The other common type of digital video is QuickTime (a file with the extension .MOV).  Focus cannot play 
files of this type.  If you have video in QuickTime format, you can convert it to AVI using the full version of 
the QuickTime player available from Apple (www.apple.com). 

Digital video takes up huge amounts of disk space – 3.6 Mbytes for each second of play, or 13 GBytes for 
a one-hour game.  If you intend to store video on disk rather than on tape within your camera, we 
recommend using the compression feature built into Focus. This allows you to convert AVI clips to MPEG 
format typically giving a 10:1 compression ratio.  Another option is to consider using standalone Firewire 
hard disks. 

2.5 File Locations And Alternative Video 
When you use Focus X2, you create a work project.  Each project concentrates on a specific piece of 
analysis focusing on the performance of an individual player or on a specific aspect of play such as 
shooting. 

A Focus Project consists of various types of information combined together.  The Project is contained in a 
Folder on your PC but some of the information used by the project can be held in other locations.  For 
example the same video might be used by several different projects each focusing on different aspects of 
performance.  When you install Focus or create a new Project, you can choose the locations for the 
project files.  These can also be managed using the Focus Project Explorer (click ‘File’ – ‘Manage 
Projects…’). 

The default locations where Focus stores data are: 

Projects  - My Documents\My Focus Files\Projects 

Category sets  - My Documents\My Focus Files\Categories 

Video clips  - Held in the same folder as the project they were captured from 

Video clips can also be stored on external disks because of the amount of storage space required.  To 
reduce this storage space, Focus also includes the ability to compress video.  Over time, a project will 
need to record alternative locations for video.  For example if the project is originally created with video on 
an external disk recognised by Windows as Drive "E:” at a later date Windows may see the same disk as 
Drive "F:”.  The Alternate Video feature allows you to tell Focus about alternative locations for the same 
video clip - either because the clip is on a different disk or because the clip now has a compressed version 
available.  Focus stores these alternative locations with the Project and automatically looks in each 
location for a valid video clip when the project is opened. 

2.6 Intra-Game Or Inter-Game Use 
You can use Focus in real-time for fast intra-game analysis or for post game analysis in more detail (inter-
game use). 

For real-time use, it is best to define small category sets and log simple events as the play progresses.  
Use this to provide fast statistically based or video feedback immediately after the game or during breaks 
in play. 

For post game analysis, you can define comprehensive category sets and log large numbers of complex 
events through a game.  Use this to provide detailed feedback on many different aspects of play. 
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2.7 Review Mode Vs. Logging Mode 
Focus has two main modes of operation depending on whether you want to log new events or review 
existing events. 

Logging Mode. 
In logging mode clicking on the category buttons will log an event.  Because the buttons are ‘live’ in this 
mode the button area is surrounded by an orange border.  Clicking on the results grid has no effect, as it 
is inactive in this mode.  Similarly, the events list is inactive when you are capturing video.  When you are 
not capturing video the event list can be used as normal - clicking on an event will move the video to that 
event. 

Review Mode. 
In review mode no new events can be logged.  However clicking on an event will move the video to that 
event.  Both the results grid and the category buttons can be used to limit the number of events displayed. 
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3 Focus Components 
Presented below are descriptions of the components that make up the Focus display.  You can use your 
mouse to drag and resize the boundaries between the components and create a Focus display matched 
to your requirements. 

3.1 Results Grid 

 
The results grid provides a summary of the logged events.  By changing the vertical and horizontal axis, or 
by clicking on a cell, column or row you can quickly show sub-sets of events.  Note that you may need to 
scroll to the right to see all of the columns. 

 

Results Grid buttons: 

 Opens the Focus X2 Options dialog on the Results Grid tab.  There are three options that allow 
you to display more detail in the results grid.  Note that after changing these options you may need 
to click on the resize column button to force windows to redraw the grid and show the extra 
information. 

 Resizes the columns to optimally fit the contents to your current window size. 

 

3.2 Event List 

 
The Events List shows the log of events recorded for the current project.  In logging mode events are 
added to the list as they are created.  In review mode you can click on an event and the video will move to 
the relevant play.  See 2.7 Review Mode Vs. Logging Mode for more details of modes.  You can sort the 
events by any of the columns by clicking on the column title bar. 

 

Event List buttons: 

 Opens the Focus X2 Options dialog on the Events List tab.  You can change the columns in the 
Event List to give more or less information.  You can also change the Event List selection action.  
This changes the way Focus behaves when you click on an event – whether video is played or 
whether Focus simply goes to the event then stops.  If you want Focus to play video when you 
click on an event you can set the amount of video either side of the event timestamp that is played.  
This is known as Pre-Roll and Post-Roll. 

An important option is whether you display event check boxes.  If you turn this on you will see 
check boxes to the left of each event.  If you click in the boxes you can select multiple events.  
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Selected events are used when you create Compilation Projects. 

 Deletes the currently selected event. 

 Edits the selected event. 

 Selects all visible events. 

 Unselects all visible events 

 Resizes the columns to optimally fit the contents to your current window size. 

 

3.3 Categories 

 
The Category buttons show the categories defined in the category set for the current project.  In logging 
mode the buttons allow you to select the attributes of each event.  In review mode the buttons allow you to 
move to sub-sets of events for analysis. 

Categories buttons: 

 Opens the Focus X2 Options dialog on the Category Buttons tab.  There are two options that allow 
you to display keyboard assignments on each button and make the buttons “sticky”.  Keyboard 
assignments are created when you define the category set and enable you to use the keyboard as 
well as the mouse to select category buttons.  Sticky buttons are used when logging and make 
Focus remember the buttons clicked for each event to speed up logging the next event if it is 
similar. 

Note that the colour of the icon here will change depending on whether Focus is in review mode or 
logging mode. 

 Changes to Logging Mode so you can add new events to the project. 

 Changes to Review Mode so you can work with the existing events. 

 

3.4 Video Player 

 
The video player shows video clips and allows you to quickly move through the video or examine sections 
of play in detail. 
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The playback slider on the right of the panel allows you to change the speed at which the video runs.  The 
control ranges from 1% to 200% of normal.  The “x1” button returns playback to normal speed. 

At the bottom of the panel a scroll bar allows you to move to any part of the video in the current play list.  

 

Video Controls (playback): 

 

Toggles between video play back and video capture.  The video controls change depending on 
this switch and only the controls relevant to the current mode are shown.  The list below covers 
playback, in capture mode the controls are limited to starting, pausing and stopping the video 
capture. 

 Switches to full screen video – the Focus interface is hidden and only the video can be seen.  
The keyboard can be used to control all Focus functions.  To see a list of the keyboard controls 
see the item “Show Keyboard Assignment” on the Focus help menu. 

 Allow you to choose the size of the video displayed in Focus.  Each time you press the button the 
video will change through Quarter, Half, Normal, Double and Stretch.  The last of these sizes the 
video depending on the current Focus window.  Stretching the video requires more processing 
power, if you have a minimum specification PC or are experiencing any video problems we 
recommend returning to Normal size. 

 Opens the play list editor so you can change the video clips associated with the current project. 

 Opens the Focus X2 Options dialog on the Player tab.  The settings here allow you to choose 
which events are displayed when you run video in sequence mode (see below). 

 Toggles whether video plays repeatedly or stops at the end of the play list. 

 Toggles whether video plays normally or in sequence.  When video plays normally each clip in 
the play list is played completely, one after the other.  In sequence mode only video associated 
with logged events is played.  This allows you to only show the video of relevance to your project 
and ignore all other video. 

 Takes a snapshot of the current video frame and saves this in Windows BMP format so it can be 
imported into other applications or printed.  You will be prompted for a name and location to save 
the snapshot file.  

 Stops the video if it is playing. 

 Plays the video play list.  While the video is playing this button changes to a pause symbol and 
can be used to stop and start the video. 

 Steps the video back by one frame. 

 Steps the video forwards by one frame. 

 Steps the video backwards to the start of the previous event. 

 Steps the video forwards to the start of the next event. 

 

3.5 Playlist Editor   
The playlist is the set of video files that are associated with the current project.  You can use the playlist 
editor to add or delete video files from the playlist.  When you play video, and ‘play as a sequence of 
events’ is not selected, the video will play through the playlist from start to end.  The video clips will be 
played in the order they are in the playlist - you can change the order of the files with the ‘Move Up’ and 
‘Move Down’ buttons. 

You can tell Focus about alternative locations for video clips using the 'Alternates' button, set the date and 
time of video clips with the 'Date/Time' button and can compress clips with the 'Compress' button. 
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4 How To Guides 
This section shows you how to carry out standard tasks within Focus such as creating a new project and 
exploring the sample project that is included in the Focus X2 download. 

4.1 Explore The Sample Project 
To let you see Focus in action, a sample project is loaded when you first start.  This allows you to explore 
how Focus works quickly without the need to define your own project or video.  (Note: to stop this help 
appearing when you start Focus, uncheck “Show Help On Startup” under the Focus Help menu.) 

 

 

Use the video controls to move through the action.  The video used here is low 
resolution to minimise download time. 

 

Look at the event list, simply click on an event and the video will move to the 
part of the play tagged to that event.  See 4.1.1 Sample Project Details for more 
information on the events. 

 

The results grid above the event list allows you to select sub-sets of events: try 
clicking on the "Hearts" text at the beginning of the row for example, and you will 
see only those events tagged to "Hearts". 

 

The category buttons are used to log events and to select sets of previously 
logged events.  Focus has two modes – Log where you create events and 
Review where you can analyse existing events.  As you are working with a read-
only sample project you will not be able to log new events until you register with 
Elite Sports Analysis – this is free, see 5.1 Registration and Purchase for details. 

 

4.1.1 Sample Project Details 

When you first run Focus, it loads a sample project complete with video and events.  This allows you to 
explore how Focus works quickly without the need to define your own project or video.  As video takes up 
a lot of disk space, the clip is restricted to about 8 seconds and has been compressed.  The sample 
project covers a soccer match and shows the events leading up to a goal with each event tagged to show 
you how Focus can be used to analyse performance. 

To explore the project try using the video controls to move through the action.  You can change the video 
speed (from 1% to 200%) with the playback rate slider or can use the scrubber control to move backwards 
and forwards through the play.  To look at the event list, simply click on an event and the video will move 
to the part of the play tagged to that event.  The results grid above the event list allows you to select sub-
sets of events: try clicking on the "Hearts" text at the beginning of the row for example, and you will see 
only those events tagged to Hearts. 

4.2 Create A New Project 
When you first run Focus, it loads a sample project complete with video and events.  Once you get a 
license to try Focus in more depth you will need to create your own projects. 

To create a project start by clicking on ‘File’ then ‘New Project’.  The dialogue box that appears enables 
you to set up the environment for the new project. 
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4.2.1 Project name and description 

The project will link together video clips with a set of events you wish to analyse.  The name and 
description identify the project and hold notes on what you were trying to achieve with this analysis. 

4.2.2 Project files 

Focus holds project information in a number of files.  We recommend that you store these in a separate 
directory within your documents area: the default is My Documents\My Focus Files.   

4.2.3 Project category definitions 

A project is based on a set of categories – these define the events you will be logging for that project.  So, 
for example a quick, real-time, analysis of a match in progress might have a single category which records 
which team has possession of the ball.  An in-depth, post game, analysis might have many categories for 
team, player, event-type, area of the pitch, event-outcome etc.  The new project can either link to an 
existing category set (a number are shipped with Focus and can be found in the ‘My Focus 
Files\Categories’ directory) or you can define a new category set.  To place an existing category set in the 
project, click on the ‘Select Category Set’ button.  To create a new category, click on the ‘Edit Category 
Sets’ button to start the category editor. 

It is important to realise that a category is embedded into a project at this point.  This means that 
subsequent changes to the category set will not be reflected in the project you are creating.  

4.3 How To Create A Highlights Clip 
Simplified highlights video creation allows a new video clip to be quickly created based on selected 
events.  You can choose to work with all the events in the project or a sub-set based on your selection.  
The amount of video to be included in the clip is set by the clip duration slider or can be picked up from the 
existing project and event settings.  This allows full flexibility over how much video you include. 

Click ‘File’ – ‘Highlights’ to start the creation of a highlights clip… 

 

You choose the events to be included in the new video 
clip – either all the events in your project or just those 
you have previously checked. 

For each event, a period of video will be created in the 
new highlights clip.  This can be a period previously set 
for each event or category or you set a specific period 
for this highlights clip. 

You can set a gap between each event in the new clip.  
This is useful especially if you plan to view the new clip 
in a video player such as Windows Media Player. 

 

4.4 How To Create A Compilation Project 
Once you have used Focus to analyse video you may want to create compilation projects based on your 
results.  A compilation project is typically smaller than the original analysis and concentrates on a 
particular aspect, for example focusing on an individual athlete or type of play.  A compilation project can 
also be used to create a highlights video clip showing key events.  Finally, you could use a compilation to 
save on disk storage space by removing all unnecessary video from your project. 

To create a compilation project you need an original (master) project with events logged and a target 
project in to which you will export data.  The target project must exist before you start the compilation 
process and must have been created using the same category set as the original master project.  To carry 
out the compilation process, start by having the master project open.  Then select ‘File’ then 
‘Compilations’ from the Focus menu.  You are prompted to select a target project for this compilation – 
you can navigate through your hard disk(s) to find the correct target project.  

Once you have selected the target, you are presented with a number of options covering what events to 
export and what to do with the video related to these events. 
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4.4.1 Events to export 

You can choose to export all the events from the master to the target or just the sub-set of events that are 
currently selected.  Note that to select events you need to have turned on ‘Display check boxes’ in the 
Focus X2 Options dialog. 

Select export all events if you want to use the compilation project to reduce video storage.  You would also 
select the ‘create new video’ option in this case (see below). 

Select export only checked events if you want to use the compilation project to save a sub-set of your 
analysis. 

4.4.2 Video to export 

You can decide how much video to export into the compilation project. 

Select ‘Add all video clips’ to create a target project that has all the same video clips in it’s play list as the 
master project.  No new video files will be created: the target project will only contain the locations of the 
current video clips. 

Select ‘Add only video clips used by events’ to create a target project that has video clips in it’s play list 
that are the same as the master project.  A video clip will only be added to the target project if it is used by 
selected events in the master project.  No new video files will be created: the target project will only 
contain the locations of the relevant video clips. 

Select ‘Create new video files’ to create new video clips which only hold sections of video used by the 
selected events.  You can decide how much video is created for each event by defining a pre-roll and 
post-roll time.  This sets the number of seconds of video before the event timestamp (pre-roll) and after 
the event timestamp (post-roll) that are copied.   

4.4.3 Event Clip Durations 

The final step is to decide how much video to put in the new project for each event.  You can choose to 
use video Pre and Post-Roll values from the individual events in the master project, use the values from 
the Project category set or to override all these settings and set a new Pre and Post-Roll here. 

4.5 Compressing Your Video Clips 
A new feature in Focus X2 v1.5 onwards is the ability to compress video clips to save disk space.  When 
video is captured into Focus, it is saved as Digital Video in .AVI format.  The compression built into Focus 
allows you to convert these clips to MPEG format typically giving a 10:1 compression ratio.  You can 
access the compression feature from a Project Playlist ('Project' -> 'Video Playlist' -> 'Compress') or from 
the Project Explorer ('File' -> 'Manage Projects' -> 'Compress'). 

4.6 Exporting Data 
A new feature in Focus X2 v1.5 onwards is the ability to export your project data to other applications via 
the Windows Clipboard.  Clicking on 'File' -> 'Export Data' accesses the feature.  You have the choice of 
exporting the results grid or the event list for the current project.  On pressing ‘OK’, the data is copied into 
the Windows Clipboard.  To use the data go to a different Windows application such as Microsoft Excel, 
select a cell in the Excel Worksheet and (within Excel) click 'Edit' -> 'Paste'. 

4.7 Working With Plugins 
Plugins are additional components that can extend the functionality of Focus X2. They can be accessed 
via the 'Tools' - 'Plugins' menu witin Focus. See also the Using Plugins topic. 

Examples of plugins include: 

> The Polar HRM2 Importer that reads a Polar heart rate data file and brings the values from it into the 
events of the current project. 

> The Focus X3 Project Exporter that allows you to select a few Events in Focus X2 and automatically 
create a Focus X3 project to view them in detail and carry out technical analysis.  

There are a number of standard Plugins available. Elite Sports Analysis can create custom Plugins to 
meet a specific user requirement.  For information on currently available Plugins please contact 
sales@elitesportsanalysis.com. 
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4.8 Introduction to Voice Control 
Continuing improvements to the Focus experience have led to the addition of Voice Control: enabling 
simpler, faster and more accurate analysis. Using Focus Voice Control simplifies data entry allowing a 
user to generate more events live during a game, saving hours of analysis time. 

> Save time by using Voice Control to tag live 

> Simple to setup it only takes a few minutes to train to you voice  

> Proven in challenging, real-life, analysis of football 

> A quick and easy upgrade to your existing Focus X2 software 

Focus Voice Control uses the speech recognition facilities built into Windows and adds a special interface 
to Focus. Instead of pressing keys or clicking the mouse, Focus lets the user speak the names of the 
category options they want to log. A microphone is required (preferably a USB connected headset type) 
and Windows speech recognition must be enabled on the PC as well as activating Focus Voice Control. 

Voice Control is sold separately from Focus X2 but can be simply enabled via a new license activation 
code.  For the latest information on Voice Control please contact sales@elitesportsanalysis.com. 
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5 Registration and Purchase 

5.1 Registration and Purchase 
There are three stages to trying and purchasing Focus X2.  This allows you to explore the product and 
ensure it is right for you before purchase. 

Check It - Try It - Buy It 

At the Check It out stage, you can freely download the software and see Focus X2 running with a sample 
Soccer project.  Focus X2 can be used as long as you like and you can see all the main functionality.  At 
this stage, Focus is limited to read only: so you cannot create new projects, categories or import new 
video clips.  If you would like to use Focus fully with your own video and team then all you need to do is 
register for an evaluation license with Elite Sports Analysis. 

At the Try It out stage, you can enable Focus X2 fully for a fixed time-period with an evaluation license 
activation key.  This allows you to try Focus with your own video and team data.  You do not have to 
download any more software or pay any money: simply register with Elite Sports Analysis by clicking 
'Help' -> 'Registration' and then the "Request an activation code button".   

Once you are happy with Focus X2, you can Buy It either directly from Elite Sports Analysis or via our 
worldwide network of local specialists.  As with the Try It stage, after purchase we will send you a license 
activation key that lifts all restrictions and fully enables Focus. 

5.1.1 Focus X2 and X3 Licenses 

Older versions of Focus X2 were linked to Focus X3 in a license hierarchy. Therefore, if you had both X2 
and X3, you would only need to activate a license for X3 and both products would be enabled. This 
version of Focus X2 includes a change to separate the X2 and X3 licenses. You can now have X2 and X3 
work separately but you will need to activate licenses in both products. 

5.1.2 Licensing Voice Control 

Focus Voice Control adds the ability to control Focus and tag events by speaking commands into a 
microphone. This feature is purchased separately from Focus X2 and is activated by the license activation 
code returned to you during the activation process. So that Voice Control activation can be completed 
successfully, it is important to include order or invoice information when following the registration process. 

5.2 Registration Detail 
Focus is enabled and locked to the specific PC on which it has been installed using a license activation 
key.  The activation key is issued by email but you first need to send information to Elite Sports Analysis 
so we can create your key... 

 
 

 

Start Focus then click on 'Help' – 'Registration'.  Now click on “Request a 
License Activation Code” to start the activation wizard. 

 

Select the type of license you need. Evaluation licenses let you try out 
Focus. Full and PLUS licenses depend on a purchase. To activate the Voice 
Control feature select Full or PLUS as appropriate and ensure you enter 
your order number in the next screen.  
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Enter as many details as possible to enable us to create your activation key. 
The minimum information required is your name, organisation and email. To 
activate Voice Activation, an ESA Order Number or Invoice Number must be 
entered here. 

 

Select how you are going to get the information to Elite Sports Analysis.  
The automatic buttons let you use the web or email or you can copy the 
information to the Windows clipboard to get the information to us manually: 
for example by pasting into a Word document to then post or fax. 

 

5.3 License Key System 
With Focus X2 you only have to download once – the Check It read only version.  When you install this, 
Focus X2 will create a Computer ID that uniquely identifies the machine on which it is installed – you can 
see this under the ‘Help’ - ‘About’ menu within the product.  To upgrade your software you simply register 
with Elite Sports Analysis by clicking 'Help' - 'Registration' and then the 'Request an activation code 
button'.  

We will send you a license activation code by email that will unlock Focus X2. The activation code either 
can enable Focus for 15 days (the Try It option) or will fully enable Focus without time limit if you have 
purchased the software. The activation code can also turn on features such as Voice Control and PLUS. 

5.4 License Activation 
To activate your license follow these steps... 

> Click 'Help' - 'Registration' then the 'Enter Activation Details' button. 

> For each of the three fields (Registered User, Organisation, Activation Code) you need to enter the 
information exactly as sent to you by email. 

> Go to the email and use your mouse to select all the text between the 'copy start' and 'copy end' marks. 
This information defines your license and controls what features are enabled. Then click 'Edit' - 'Copy' to 
put the information into the Windows Clipboard. 

> Click on the 'Paste Activation Details...' button.  You should see the information appear in the three 
fields. Extra information from the email is also added to Focus at this point. 

> Click 'OK' to activate your license. 

You can later review licensing information by clicking 'Help' - 'Registration'. Extra features (such as Voice 
Control) can bee see by clicking the 'Features' button on this window. 

If you have any trouble installing your licence you can contact Elite Sports Analysis support by emailing   
support@elitesportsanalysis.com. 
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6 Contact Details 
For More Information please contact: 

Elite Sports Analysis support - support@elitesportsanalysis.com, or browse to 
www.elitesportsanalysis.com. 
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